Antenna Gain Calibration

Michael Lindqvist, Onsala Space Observatory, Sweden
How can we deliver better calibrated data to the user?

The answer to this question is very simple but it is not so easy to realize: we need to determine $T_{\text{cal}}(K)$ and the combination of DPFU (Degrees per Flux Unit) and the gain curve $(G)$.

- onoff
- gnplt
How can we deliver better calibrated data to the user?

The answer to this question is very simple but it is not so easy to realize: we need to determine $T_{\text{cal}}(K)$ and the combination of DPFU (Degrees per Flux Unit) and the gain curve ($G$).
Important files

- `flux.ctl /usr2/control`
- `pointc.ctl /usr2/control`
- `*.rxg /usr2/control/rxg_files`
- `*.prc /usr2/proc`
- `*.log /usr2/log`
ONOFF

- Power on source [ONSO]
- Power on source with noise diode on [ONSC]
- Power off source with noise diode on [OFFC]
- Power off source with noise diode off [OFFS]
- Power off source with no signal for “zero” [ZERO]

SEFD is the "system equivalent flux density" (Jy), defined as the flux density of a radio source that doubles the system temperature. SEFD = Tsys/G
Comp = \frac{\text{ONSC} - \text{ONSO}}{\text{OFFC} - \text{OFFS}}

\text{SEFD} = S \times \frac{\text{OFFS} - \text{ZERO}}{\text{ONSO} - \text{OFFS}}

T_{sys} = T_{cal} \times \frac{\text{OFFS} - \text{ZERO}}{\text{OFFC} - \text{OFFS}}
\[ T_{\text{cal}}(\text{Jy}) = S \times \frac{\text{OFFC} - \text{OFFS}}{\text{ONSO} - \text{OFFS}} \]

\[ T_{\text{cal}}(\text{K}) = \text{DPFU} \times \text{gain}(\text{el}) \times T_{\text{cal}}(\text{Jy}) \]

\[ T_{\text{cal}}(r) = \frac{T_{\text{cal}}(\text{K})}{T_{\text{cal,rxg}}(\text{K})} \]
### EVN Block Schedule

**Session 1 2017**

**Version 5.0**

**02 Feb 2017**

<table>
<thead>
<tr>
<th>CODE</th>
<th>EVN</th>
<th>TELESCOPES</th>
<th>CORR</th>
<th>TOT</th>
<th>/ST</th>
<th>DAY</th>
<th>UT-START</th>
<th>UT-STOP</th>
<th>COMMENTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1L7</td>
<td>Jb1</td>
<td>Wb1 Ef Mc</td>
<td>3,23</td>
<td>0.23</td>
<td>Eu</td>
<td>054</td>
<td>1100(23/02)</td>
<td>1200(23/02)</td>
<td>512 Mbps</td>
</tr>
<tr>
<td>EP103A</td>
<td>Jb1</td>
<td>Wb1 Ef Mc</td>
<td>73.72</td>
<td>5.99</td>
<td>Eu</td>
<td>054</td>
<td>1000(23/02)</td>
<td>0100(24/02)</td>
<td>Ar</td>
</tr>
<tr>
<td>CL17L1</td>
<td>Jb1</td>
<td>Wb1 Ef Mc</td>
<td>0.00</td>
<td>0.00</td>
<td>Eu</td>
<td>055</td>
<td>0700(24/02)</td>
<td>1100(24/02)</td>
<td></td>
</tr>
<tr>
<td>EM127A</td>
<td>Jb1</td>
<td>Wb1 Ef Mc</td>
<td>36.63</td>
<td>3.26</td>
<td>Eu</td>
<td>055</td>
<td>1600(24/02)</td>
<td>2300(24/02)</td>
<td>21 cm</td>
</tr>
<tr>
<td>EM127B</td>
<td>Jb1</td>
<td>Wb1 Ef Mc</td>
<td>27.87</td>
<td>2.53</td>
<td>Eu</td>
<td>056</td>
<td>0800(25/02)</td>
<td>1300(25/02)</td>
<td>21 cm</td>
</tr>
<tr>
<td>EX036C</td>
<td>Jb1</td>
<td>Wb1 Ef Mc</td>
<td>11.06</td>
<td>0.92</td>
<td>Eu</td>
<td>056</td>
<td>1600(25/02)</td>
<td>1800(25/02)</td>
<td></td>
</tr>
<tr>
<td>N17L1</td>
<td>Jb1</td>
<td>Wb1 Ef Mc</td>
<td>12.29</td>
<td>0.69</td>
<td>Eu</td>
<td>056</td>
<td>1900(25/02)</td>
<td>2200(25/02)</td>
<td>512 Mbps</td>
</tr>
<tr>
<td>G022A</td>
<td>Jb1</td>
<td>Wb1 Ef Mc</td>
<td>254.36</td>
<td>11.06</td>
<td>Eu</td>
<td>057</td>
<td>0330(26/02)</td>
<td>1530(26/02)</td>
<td>+VLBA+Y27</td>
</tr>
<tr>
<td>EP102</td>
<td>Jb1</td>
<td>Wb1 Ef Mc</td>
<td>60.37</td>
<td>4.61</td>
<td>Eu</td>
<td>057</td>
<td>1730(26/02)</td>
<td>0330(27/02)</td>
<td>+MERLIN</td>
</tr>
<tr>
<td>N17C1</td>
<td>Jb1</td>
<td>Wb1 Ef Mc</td>
<td>10.37</td>
<td>0.69</td>
<td>Eu</td>
<td>059</td>
<td>1300(28/02)</td>
<td>1600(28/02)</td>
<td>512 Mbps</td>
</tr>
<tr>
<td>CL17C1</td>
<td>Jb2</td>
<td>Wb1 Ef Mc</td>
<td>0.00</td>
<td>0.00</td>
<td>Eu</td>
<td>060</td>
<td>0700(01/03)</td>
<td>1100(01/03)</td>
<td>6 cm</td>
</tr>
</tbody>
</table>

- **onoff**
- **gnplt**
- **rxg-file (Tcal(K), DPFU, gaincurve)**
- **log-file+rxg-file**
- **antabfs.pl**
- **antab-file to the user**
The following table gives the **median absolute error** in the antenna gain amplitude. This number will be approximately half the error in the SEFD and is the same that you see in AIPS gain plots. The number in brackets after each entry is the number of experiments that were used.
# Feedback from JIVE

<table>
<thead>
<tr>
<th></th>
<th>18cm</th>
<th>6cm</th>
<th>5cm</th>
</tr>
</thead>
<tbody>
<tr>
<td>AR</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BD</td>
<td>0.21 (5)</td>
<td>0.14 (7)</td>
<td></td>
</tr>
<tr>
<td>EF</td>
<td>0.05 (11)</td>
<td>0.07 (6)</td>
<td>0.07 (14)</td>
</tr>
<tr>
<td>HH</td>
<td>0.05 (4)</td>
<td></td>
<td>0.08 (9)</td>
</tr>
<tr>
<td>IR</td>
<td>2.01 (2)</td>
<td>0.12 (4)</td>
<td></td>
</tr>
<tr>
<td>JB</td>
<td>0.42 (11)</td>
<td>1.04 (6)</td>
<td>0.21 (14)</td>
</tr>
<tr>
<td>MC</td>
<td>0.11 (11)</td>
<td>0.05 (7)</td>
<td>0.12 (14)</td>
</tr>
<tr>
<td>NT</td>
<td></td>
<td>0.09 (7)</td>
<td>0.22 (14)</td>
</tr>
<tr>
<td>ON</td>
<td>0.12 (11)</td>
<td>0.05 (7)</td>
<td>0.12 (14)</td>
</tr>
<tr>
<td>RO</td>
<td>0.08 (2)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SH</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SR</td>
<td>0.22 (7)</td>
<td></td>
<td>0.08 (14)</td>
</tr>
<tr>
<td>SV</td>
<td>0.09 (9)</td>
<td>0.04 (7)</td>
<td></td>
</tr>
<tr>
<td>T6</td>
<td>0.19 (4)</td>
<td>0.05 (4)</td>
<td></td>
</tr>
<tr>
<td>TR</td>
<td>0.25 (11)</td>
<td>0.09 (7)</td>
<td>0.11 (11)</td>
</tr>
<tr>
<td>UR</td>
<td>0.15 (10)</td>
<td>0.07 (7)</td>
<td></td>
</tr>
<tr>
<td>WB</td>
<td>0.09 (11)</td>
<td>0.05 (7)</td>
<td>0.11 (14)</td>
</tr>
<tr>
<td>YS</td>
<td></td>
<td>0.04 (7)</td>
<td>0.08 (11)</td>
</tr>
<tr>
<td>ZC</td>
<td>0.07 (11)</td>
<td>0.21 (5)</td>
<td></td>
</tr>
</tbody>
</table>
Feedback from JIVE

Antabfs and feedback name and shame
Antenna Gain Calibration

Part 1: Gain Curve and Diode Temperature Calibration with ONOFF

Alastair Gunn
Jodrell Bank Observatory
University of Manchester
UK

alastair.gunn@manchester.ac.uk
1. Introduction

This course covers the use of the Field System tasks onoff and gnplt for antenna gain calibration. Instruction will be given on the preparation and execution of onoff for the automatic acquisition of amplitude calibration data. Attendees will learn about the necessary procedure files, methods of measuring noise diode temperature and gain curves and the interpretation of the resulting log files. The second half of the course provides training on the use of gnplt for the analysis of calibration data. Much of the theoretical background for this course can be found in the seminar notes for Pointing and Single Dish Amplitude Calibration Theory.

2. What are we trying to do?

In the seminar Pointing and Single Dish Amplitude Calibration Theory it was shown how absolute calibration of both antenna gain and system temperature can be made and then combined to estimate the SEFD in Jy. This is the relevant quantity for amplitude calibration.

A convenient way of collecting gain calibration data is to use the Field System program called aquir. This program cycles around a supplied list of calibrator sources, making observations of all those above the horizon. For each source, it first optionally executes the fivpt task that makes a series of observations around the nominal pointing position and fits for the position offset giving maximum power. In order to get accurate gain elevation information it is essential to have an accurate pointing model. Such data can also be used to update the pointing model used for observations. However, a separate maintenance workshop, Automated Pointing Models Using the FS, will address the issue of fivpt operation. Following fivpt, the aquir program runs the onoff task for each source to determine the power ratio in the equation

$$G = \frac{P_{on-source} - P_{off-source}}{P_{cal-on} - P_{cal-off}} \frac{T_{cal}}{S},$$

where $G$ is the antenna gain, $T_{cal}$ is the cal diode temperature, $S$ is the source flux, $P_{on-source}$ and $P_{off-source}$ are the power levels on and off source respectively (with the noise diode switched off) and $P_{cal-on}$ and $P_{cal-off}$ are the power levels off source with the noise diode switched on and off respectively. Combined with estimates of the flux densities of the calibrator sources and $T_{cal}$, this program can be used to collect a large database of antenna gain values allowing us to fit for the gain curve $g$ and the DPFU.

The system temperature $T_{cal}$, divided by the net antenna gain $G$ in KJy$^{-1}$ can be considered the cal diode strength in Janskies, or $T_{cal}$. Unlike $T_{cal}$, $T_{cal}$ depends on elevation because the antenna gain curve $g$ is elevation dependent. Direct measurements of this $T_{cal}$ are made by the onoff task automatically by comparing the power levels obtained by switching the cal diode on and off with the change by going on and off a source of known flux density.

To calibrate an antenna, onoff measurements should be performed regularly. A new set of $T_{cal}$ measurements are checked to see if they are consistent with the adopted $T_{cal}$, gain polynomial $g$ and DPFU. If they are not, the adopted parameters are changed by analysing the onoff results with gnplt. The use of gnplt is dealt with in the second part of this Maintenance Workshop. If just the scaling of the predicted $T_{cal}$ versus elevation is wrong but the shape is right, we can simply change the adopted $T_{cal}$ or DPFU until it fits. If it is the shape that doesn’t fit, then the antenna gain curve $g$ must be refitted. Once the combination of $T_{cal}$, gain curve and DPFU that best matches the data are found, these values can be adopted to derive $T_{sys}$ information for actual observations. This process is described in the seminar Generating ANTAB Tsys Files. The following notes give details on preparing and running the onoff task.
3. Setting up a calibration

There are several preliminary steps required before running the onoff program. These are detailed below. For more information, the Field System help file for onoff is shown in Appendix 1.

a). Provide an initial ‘rxg’ file

The Field System requires a file that details the current receiver parameters and calibration data for the telescope/receiver system in use. These files have the ‘rxg’ extension and are kept in the directory /us2/fs/control/rxg_files. An example ‘rxg’ file for the Lovell 76m telescope at Jodrell Bank Observatory is shown in Appendix 2. This example is for L-band (18cm) observations. If you do not have a previously defined ‘rxg’ file, several default files are available in the appropriate directory. Edit one of these to contain the relevant parameters for telescope/receiver combination. The Field System decides which ‘rxg’ file to use based on the effective LO setting within the file so ensure that these settings agree with the effective LO issued by your LO command in the Field System.

Several astronomical stations operate several telescopes and it is also not uncommon for different receivers/noise diodes to be used at different times. Hence, several files with the same LO setting may be required at your station and these should be held in a separate directory. Copy the relevant file to the rxg_files directory before running onoff. This process may eventually be automated with an FS script. It is also advisable to keep backup copies of all ‘rxg’ files since this provides an accurate record of the calibration parameters used at any time at your station. In fact, the gnplt program, which will ultimately be used to update the ‘rxg’ file, retains previous data as commented lines at the bottom of the ‘rxg’ files, but users may also wish to keep the files separately for ease of access.

Familiarise yourself with the format of the ‘rxg’ file. Make sure the LO, date, beamwidth format, available polarisations, DPFUs, gain polynomial, $T_{\text{cal}}$ versus frequency, antenna temperature $T_{\text{rec}}$ and spill-over table are appropriate. If you do not have values of the $T_{\text{cal}}$ versus frequency, estimate a single value and duplicate this value over perhaps ten frequency points across the entire receiver bandwidth. It is important that the range of frequencies in the ‘rxg’ file is equal to or greater than the range of frequencies over which you will be setting the video converters (VCs) or BBCs.

b). Edit the acquir.prc file

The aquir program uses the acquir.prc procedure file held in the usual procedure directory of the FS. An example of some of the important procedures within this file can be found in Appendix 3. Edit this file before running onoff. Firstly, ensure the calonnf and caloffnf procedures exist in the acquir.prc file according to the instructions in the onoff help file (Appendix 1). Next, edit the initp procedure to setup the parameters for onoff. In the example the relevant line is,

```
onoff=2,2,60,3.0,1200,allvc
```

This performs 2 repetitions with a 2 second integration time, performs elevation-only offsets above 60 degrees elevation, steps 3 beamwidths off source for off-source measurements, allows 1200 seconds for the process to return its status and uses all VCs. Generally, IF channels should not be used for $T_{\text{cal}}$ against frequency determination since their frequency is not properly specified. IF channels can be used for gain-elevation determination and for fivpt. Also note that you should not use both the LSB and USB of a single VLBA BBC at the same time, as this creates problems for analysis. Note that the fivpt command for aquir is also defined here but this is covered in the maintenance workshop Automated Pointing Models Using the FS.
Next, ensure the acquire procedure points to the control file you want to use for these measurements (see section d. below) and that the log filename is set for the Field System. In the example the relevant lines are,

```
sy=run aquir /usr2/control/ctlpo.ctl $ &
log=aquir
```

Also, ensure the ‘rxg’ filename and the LO settings agree with those in your ‘rxg’ file as given in the calrx command. In the example the relevant line is,

```
calrx=calrx,fixed,1510.0,1510.0
```

Finally, it is helpful to be able to include all relevant telescope/receiver parameters in the acquire log file. This can be achieved by adding a procedure to the station library (called logpar in the example acquir.prc file) which logs your telescope/receiver setup (e.g. local synthesiser values, band switches, carousel positions etc). In the example, the logpar command is issued in the acquire procedure.

c). Edit the ctlpo.ctl file

In the above example, we told the aquir program to use the control file ctlpo.ctl. An example of such a file is found in Appendix 4. This file lists the calibration sources around which the aquir program should cycle. For each, aquir will perform those tasks selected in the line for each source. In the example file, only one source is selected (uncommented), thus,

```
3c286 132849.66 +304558.7 1950 PREP -2 -2 5 0 POSTP 10
```

This line instructs aquir to run the onoff task only on target 3c286, to wait 5 minutes for onoff to complete, run the postp procedure on completion (held in the acquir.prc file) and then wait 10 minutes before repeating the cycle. For full details of what each parameter means, see the descriptions in the example ctlpo.ctl file. In this file, you can select any number of sources to use by un-commenting them. They can be in any order you choose and can be duplicated if desired. Generally, if you are interested only in $T_{\text{cal}}$ measurements, a number of sources should be used at reasonable elevation, for pointing measurements different sources at all elevations and azimuths should be tracked, and for gain curve determination a single source at a time should be followed for its full elevation range until a complete 0-90 degree set of measurements are recorded.

Note that the ctlpo.ctl file also contains details of the elevation limits and elevation mask for your telescope. If you are doing the gain curve then you may want to start at low elevation to pull the curve down, so make sure these numbers allow you to run aquir at low elevations (as low as 2 degrees).

An additional file that is required for aquir to run is the file containing details of the source flux densities so that onoff can deduce the expected power levels at each frequency. This file is held in the usual control directory and is called flux.ctl. It is unlikely you will ever have to look at this file but for completeness a copy is shown in Appendix 6.

d). Edit your setup procedure to select LOs and devices etc.

In the setup command for onoff detailed in section b. above, we requested use of all VCs for the determination of calibration data. Generally, we would set the VCs up to cover as wide a band as possible across the receiver band in order to determine the $T_{\text{cal}}$ versus frequency dependence. Often,
if we are primarily concerned with the $T_{\text{cal}}$ versus frequency dependence, we can run separate instances of `aquir` to measure the different, narrower subbands of the receiver band and hence build up a fine grid of points for fitting. To do this, `aquir` can be stopped using the `kill` command, the VC settings changed, and `aquir` restarted. If doing this, there is no need to select a new `aquir` log file since the additional data will be added to the old and `gnplt` will take care of extracting it. We only need to change log file if we change effective LO, receiver, noise diode or telescope.

In practice, it is convenient to set up a number of procedures in the station library, which quickly define the VC frequencies and other parameters we want to use for each band at which we operate. An example of such a set up procedure can be found in Appendix 5 for the Lovell 76m telescope operating at 5GHz (C-band) in dual polarisation mode. Note that many of the commands in this procedure library are station specific since they are setting synthesiser values and band switches etc. Importantly, the LO command issued in this procedure library should agree with those found in the `acquir.prc` file and the ‘rxg’ file, although in the examples given in these notes, they do not agree! Note also that patch commands etc. are also provided, as this is a requirement of `onoff`. You can either edit a single procedure each time you run `aquir` or provide different setups for different telescopes/receivers/frequencies.

4. Running the Calibration

After setting up for `onoff`, it is a very simple task to gather the required data. The following assumes that the telescope is operational, that pointing offsets have been measured and set, the telescope focus is correct and the IF attenuators are appropriately set. For example, we need only run a local setup procedure (Appendix 5), select the `acquir.prc` procedure file and run `acquire`;

```
> c5gdp
> proc=acquir
> acquire
```

The data acquisition can be stopped by issuing the `kill` command at any time. As usual, the FS reports the output of `aquir` to the terminal as well as to the `acquire` log file. Understanding this log file is not essential since `gnplt` extracts and displays the essential information used in the calibration. However, some basic details are given below.

An example log file from `aquir` is shown in Appendix 7. This shows a single measurement cycle on the calibrator 3c161 using the Lovell 76m telescope at L-band (1.6 GHz, 18 cm). Once started, `aquir` reports the telescope/receiver setup using the local procedure `logpar`. After arriving on source, `onoff` reports the current gain information for each selected VC derived from the current ‘rxg’ file that it found matching the defined LO command. These lines, one for each detector, are of the form;

```
2004.047.16:34:52.29#onoff#APR 1u   1631.99 9.000    16.7  1.200000 0.83418  1.001014 1510.00 c 0.16896
```

and list the central frequency, currently defined $T_{\text{cal}}$ (may be interpolated from the values in the ‘rxg’ file), the expected flux from the target, the DPFU, the gain at this elevation, the product of DPFU and gain, the effective LO and the beamsize (FWHM) for this detector. There next follows a series of lines of the form;

```
2004.047.16:34:56.31#onoff#ONSO     3.3   0.00000   0.00000 1u   6531.5      2.1 2u   3563.0      2.8
```

which give the elapsed time in seconds, the azimuth and elevation offsets, a detector, its counts and the corresponding error (and the same for a second detector). The ONSO, ONSC, OFFC and OFFS codes signify whether the measurement is on or off source with the cal diode on or off and ZERO
signifies measurements with full attenuation (zero level). onoff proceeds to measure values on either side of the target before summarising the results in SIG lines. The final result for this measurement is listed in VAL lines, in the example below, as follows;

```
2004.047.16:36:58.46#onoff# source Az El De I P Center Comp Tsys SEFD Tcal(j) Tcal(r)
2004.047.16:36:58.46#onoff#VAL 3c161 114.3 10.1 1u 1 l 1631.99 0.9457 43.76 43.0 8.852 0.9846
2004.047.16:36:58.46#onoff#VAL 3c161 114.3 10.1 2u 2 r 1631.99 0.9626 49.33 41.8 9.812 0.9822
2004.047.16:36:58.46#onoff#VAL 3c161 114.3 10.1 3u 1 l 1641.99 0.9573 53.11 45.7 7.752 0.8622
2004.047.16:36:58.46#onoff#VAL 3c161 114.3 10.1 4u 2 r 1641.99 0.9589 59.21 44.0 7.438 0.7445
2004.047.16:36:58.46#onoff#VAL 3c161 114.3 10.1 5u 1 l 1651.99 0.9562 64.12 46.6 6.534 0.6932
2004.047.16:36:58.46#onoff#VAL 3c161 114.3 10.1 6u 2 r 1651.99 0.9589 60.81 42.9 9.812 0.8485
2004.047.16:36:58.46#onoff#VAL 3c161 114.3 10.1 7u 1 l 1661.99 0.9562 42.3 42.5 8.476 0.9822
2004.047.16:36:58.46#onoff#VAL 3c161 114.3 10.1 8u 2 r 1661.99 0.9562 42.9 42.3 8.852 0.8622
```

This table shows the crucial results. For each detector, it shows the azimuth and elevation, detector name, IF channel, polarisation, central frequency, gain compression, $T_{sys}$, SEFD, $T_{cal,j}$ and the ratio of the adopted to the measured $T_{cal}$, called $T_{cal}(r)$. There are obvious things to check in these results. Firstly, the measured $T_{sys}$ values should be close to what you expect for this telescope/receiver combination. Secondly, if the current calibration information (found in the current ‘rxg’ file) is accurate, the final column of numbers should all be close to unity. If some are not, there may be reasons other than bad calibration (for example, saturation or extreme RFI). If all these numbers are not close to 1.0 the calibration is almost certainly wrong. Analysis of the data can then be achieved using gnplt to formulate an updated ‘rxg’ file, which better represents the combination of DPFU, gain curve and $T_{cal}$ versus frequency.

The operational procedures that stations follow in order to acquire accurate calibration data is dependent on local constraints. Amplitude calibration for astronomical observations is of paramount importance because it enables a calibration of the correlated amplitudes leading to more reliable scientific results.

Within the EVN, for example, which observes 3 or 4 times per year, typically for 3 week intensive periods, calibration experiments are part of the agreed schedule of observations. Within these reserved periods, telescope operators are free to pursue whatever regime is necessary to provide accurate calibration data. With typically 3 or 4 observing bands per session, this involves a considerable work load. Hence, gain curves are generally not measured more than once per year, although these must always be re-measured if changes are made to the telescope structure. Many EVN stations do, however, manage to provide updated gain curves for each EVN observing session. It is important to remember that gain-elevation and $T_{cal}$ against frequency analyses should ideally be done in two separate observing runs, since the results are interdependent. Checking the $T_{cal}$ values across each observing band in use is now a routine part of EVN operations and these results are filtered through to the users by combining them with measurements taken during actual scientific experiments. How this is achieved is detailed in the seminar Generating ANTAB $T_{sys}$ Files.

The choice of calibration source is important. For 25m antennas up to about 5GHz, Cygnus A is a good target source. For larger antennas or higher frequencies, experimentation to identify suitable calibrators from the flux.ctl file is advisable.

Another source of confusing results is the incorrect use of local antenna control software by acquir or onoff. For example, if the local control software reports an ‘onsource’ condition before the antenna has settled, the calibration results will be meaningless.
Appendix 1: ONOFF help file

Syntax:     onoff=rep, intp, cutoff, stp, wait, devices

Response:   onoff/rep, intp, cutoff, stp, wait, ssize, mfwhm
            onoff/device, if, pol, fwhm, center, flux, dpfu, gain, product

Settable parameters:

- **rep**: Number of repetitions, 1 to 99. Default is 2.
- **intp**: Integration period, 1 to 10 seconds. Default is 1.
- **cutoff**: Elevation above which to step in elevation rather than azimuth, in degrees, default 75.
- **stp**: Distance off source for off source and calibration points, in multiples of a beamwidth. Default is 3.0.
- **wait**: Seconds to wait for onsource for each point, 1-1200 seconds allowed, default 120.
- **devices**: One or more of all standard device mnemonics, plus all, allvc, formvc, and formif for Mark III/IV, plus allbbc, allu, alll, formbbc, and formif for VLBA/4. For all racks station defined detectors u5 and u6 are supported if the station has them implemented.

Monitor-only parameters:

- **ssize**: source size, degrees
- **mfwhm**: maximum full-width-half-maximum of all selected devices, degrees
- **device**: a selected device's mnemonic
- **if**: if chain for device, 1-3 for Mark III/IV and LBA4, a-d for VLBA/4
- **pol**: polarization for device, l for left and r for right
- **fwhm**: full-width-half-maximum for device, degrees
- **center**: center frequency for device, MHz
- **tcal**: Noise diode temperature for center, degrees K
- **flux**: Source flux for center, Janskys
- **corr**: Source flux correction for center and fwhm, dimensionless
- **dpfu**: Degrees-per-Flux-Unit, for band of device, in degrees/Janskys
- **gain**: gain curve value for band of device at current elevation, dimensionless
- **product**: dpfu*gain for device, degrees/Janskys

Comments:
This version works only with Mark III/IV or VLBA/4 devices, i.e. user defined devices are not supported.

The parameters should be setup by issuing a onoff=... command. A measurement is started by issuing a simple onoff. This will recover the current values for the display only parameters and schedule an external program onoff. See the onoff manual in Volume 2 (currently out-of-date).

The current command antenna position including offsets is assumed to be 'onsource.'

It is recommended that nothing else be done, e.g. running a schedule, while this command is executing. Since this command may run for an extended period of time, a mechanism has been supplied for aborting: enter sy=brk onoff & as a SNAP command. After aborting, the offsets will be returned to their original values.

In order for this command to work, the following conditions must be met: (1) the detector devices have been set up by the Field System, (2) the appropriate lo= commands have been issued, (3) for a Mark III/IV or LBA4 rack only, the IF distributors have been set up by the Field System and must be in remote, (4) for a Mark III/IV or LBA4 rack only, if a video converter is used as a detector, the appropriate patch= command must have been issued, and (5) for a VLBA/4 rack only, if a BBC is used as a detector, the appropriate BBC IF input must be selected with a bbcXX= command.

If a noise diode temperature is less than zero, it is assumed that there is no noise diode to use for that detector. All measurements for that channel will be made assuming the
absolute value of the diode temperature is the system temperature. Thus if the noise diode
temperature is -100, the power measurements will come out as a percentage of the system
temperature. Other quantities dependent on the noise diode will be displayed as 0.0.

If either noise diode temperature is greater than zero, then two procedures must be
available: calonnf and caloffnf, which are used to turn the noise diode on and off
respectively. The recommended form for these procedures is:

CALONNF: calon
    !+1s
    sy=go onoff &

CALOFFNF: caloff
    !+1s
    sy=go onoff &

calon and caloff are local procedures that do whatever is necessary to turn the noise source
on and off, respectively.

If station dependent detectors u5 and/or u6 are used, two additional procedures must be
available to turn the signal on and off to the detectors. The recommended form of this
procedures is:

SIGONNF: sigon
    !+1s
    sy=go onoff &

SIGOFFNF: sigoff
    !+1s
    sy=go onoff &

sigon and sigoff are local procedures that do whatever is necessary to turn the signal to
the station dependent detectors on and off, respectively.

The "formbbc", "formif", and "formvc" detector device parameters will cause the BBCs, IFs,
or VCs (respectively) that are current defined for recording by the formatter to be selected
as detectors. This is useful for checking SEFDs in all channels to be used in an experiment.

There is a known bug in the use of these procedures: calonnf, caloffnf, sigonnf, and
sigoffnf, that may require the last two lines to be repeated in each procedure. In other
words after the first line, each procedure should contain:

    !+1s
    sy=go onoff &

The indication that this is needed is if onoff seems to hang after executing one of these
procedures. Please see the "Known Bugs" section of the latest update notice for more
details.

The default wait time for of 120 seconds is generous, but can be adjusted if necessary.
Slower antennas may need a longer time. Shorter times are only useful to make onoff give-up
sooner if there is a problem getting on-source.
Appendix 2: Example ‘rxg’ file for Lovell 76m telescope at L-band

* calrx.rxg - L band receiver parameter definition for Jodrell Bank Lovell telescope
* first line: LO values and ranges, format:
  * type  frequencies
  * if type is range, the two values: lower and upper frequencies
  * if type is fixed, then one or two fixed value
  * frequencies in MHz

fixed 1510 1510
*
* 2nd line: creation date
* format: yyyy ddd or yyyy mm dd (0 is valid for all for intial set-up)
* 2005 03 01
*
* 3rd line: FWHM beamwidthm format:
  * model value

* if type is frequncy, then fwhm=value*1.22*c/(freq*diameter)
  * value is 1.0 if omitted
* if type is constant, then fwhm=value (degrees)

frequency 1.0
*
* 4th line polarizations available
*
* one of both of lcp and rcp
* lcp rcp
*
* 5th line: DPFU (degrees/Jansky) for polarizations in previous line in order
* 1.183967 1.1823
*
* 6th line: gain curve (only one) for ALL polarizations in 4th line
* TYPE FORM COEFFICENTS ... *
* FORM = POLY only for now
* TYPE = ELEV and ALTAZ only for now
* COEFFICENTS = variable number of number values
*
* maximum coefficients 10 *

ELEV POLY 0.75147458 0.0085738926 4.4339e-05 -4.5298173e-06 5.4629099e-08 -2.1277245e-10 *
*
* 7th and following lines: tcal versus frequency
* Format: POL FREQ TCAL *
* where:
  * POL  polarization rcp or lcp
  * FREQ  frequency (MHz)
  * TCAL  degrees K
*
* MAXIMUM ENTRIES 100, group by polarization
* then sorted by increasing freq
*
lcp 1632.0 6.8312
lcp 1642.0 6.1360
lcp 1652.0 7.9144
lcp 1662.0 9.4616
lcp 1682.0 6.0362
lcp 1692.0 8.9938
lcp 1702.0 6.8228
rcp 1632.0 6.1670
rcp 1642.0 6.1920
rcp 1652.0 7.6162
rcp 1662.0 9.0776
rcp 1682.0 5.3814
rcp 1692.0 6.5397
rcp 1702.0 6.5355
*
*tcal table ends with end_tcal_table record
end_tcal_table
* 
* Trec - receiver temperature, degrees K 
* 
* if value is zero, no opacity corrections are used 
* 
* 0.0 
* 
* Spillover table 
* 
* format: 
*  elevation temperature 
* where: 
*  elevation is angular degrees above horizon 
*  temperature is Kelvin degrees of spillover noise 
* 
*spillover table ends with end_spillover_table record 
* 
end_spillover_table
Appendix 3: The important procedures in the ACQUIR.PRC file

```
define kill 05068000323
    " Stopping ACQUIR..."
sy-brk aquir &
sy-brk fivpt &
sy-brk onoff &
log-station
enddef

define initp 05067173207
    " Initialising ACQUIR setup..."
caloff
    " FIVEPT setup..."
fivept=azel,1,7,0.3,2,11,1200
    " ONOFF setup..."
onoff=2,2,60,3.0,1200,allvc
check=
sy-go aquir &
enddef

define acquire 05067173206
    " Running ACQUIR"
sy-run aquir /usr2/control/ctlpo.ctl $ &
    " Setting LOG file name"
log-acquir
    " Setting CALRX file"
calrx=calrx,fixed,1510.0,1510.0
    " Logging System parameters - site specific"
logpar
enddef

define caloffnf 05067173218
caloff
sy-go onoff &
!+1s
sy-go onoff &
enddef

define calonnf 05067173222
calon
sy-go onoff &
!+1s
sy-go onoff &
enddef
```
Appendix 4: Example CTLPO.CTL file

* CTLPO.CTL control file for AQUIR
* Data formats:
* Procedure names: 12 character Field System procedure or command name.
* Waits: minutes for corresponding procedure to complete
*   -2 => don't execute this procedure, it's just a place holder
*   -1 => self suspend after entering command, expect a GO,AQUIR
*     in order to continue
*   for FIVPT, ONOFF, and PEAKF waits:
*   0 -> don't execute this command
*   >0 -> wait that many minutes for FIVPT, ONOFF, or PEAKF program to complete, OFF'ing them if they aren't done
* Elevations: degrees
* Source Names: 10 characters
* Right Ascension: hhmmss.s
* Declination: ddmms
* Epoch: yyyy.y
* First data record:
* Setup procedure, Setup wait, Terminate Procedure, Terminate wait,
* Upper elevation Limit, ONSOURCE Wait,
* Amount to lead source when calculating what's up
* Sources outside elevation limits are considered 'down'
* INITP -1 INITP -2 91 180 180
* Elevation mask for lower elevation limit: AZ EL AZ EL ... AZ
* may contain multiple lines, an incomplete line ends with an EL
* 0 2 360
* Source records:
* Name, R.A., Dec., Epoch, Preob procedure, Postob procedure,
* FIVPT wait, ONOFF wait, PEAKF wait,
* Preob procedure, Postob Wait
* The nominal maximum number of sources is 200, but it may vary.
* If there are too many in the file, the program will print a message with the current number.
* *3c48 013741.30 +330935.1 2000 PREP -2 -2 5 0 POSTP -2
* *3c84 031948.16 +413042.1 2000 PREP -2 -2 5 0 POSTP -2
* *3c123 043355.20 +293414.0 1950 PREP -2 -2 5 0 POSTP 10
* *3c147 053843.51 +494942.8 1950 PREP -2 -2 5 0 POSTP 10
* *3c161 062710.10 -055304.8 2000 PREP -2 -2 5 0 POSTP 5
* 3c286 132849.66 +304558.7 1950 PREP -2 -2 5 0 POSTP 10
* *3c295 141120.65 +521209.1 2000 PREP -2 -2 5 0 POSTP 5
* *3c309.1 145907.58 +714019.9 2000 PREP -2 -2 5 0 POSTP -2
* *3c348 164840.00 +004035.0 1950 PREP -2 -2 5 0 POSTP -2
* *3c353 171753.30 -005550.0 1950 PREP -2 -2 5 0 POSTP -2
* *cygnusa 195928.40 +404042.0 2000 PREP -2 -2 5 0 POSTP 15
* *aurusa 123049.42 +123232.0 2000 PREP -2 -2 5 0 POSTP -2
*
Appendix 5: Example calibration setup procedure for Lovell telescope

" calibration setup for 5 ghz dual polarisation – station specific
define c5gdp
" setup frequencies across the band, 8 mhz spacing, 8 mhz bandwidth
vc01=126.99,8.000
vc02=126.99,8.000
vc03=134.99,8.000
vc04=134.99,8.000
vc05=142.99,8.000
vc06=142.99,8.000
vc07=150.99,8.000
vc08=150.99,8.000
vc09=158.99,8.000
vc10=158.99,8.000
vc11=166.99,8.000
vc12=166.99,8.000
vc13=174.99,8.000
vc14=174.99,8.000
!+1s
valarm
" select dual polarisation
ifd=*,*,nor,nor
" set the effective LO – site specific
lo=lo1,4840.00,usb,lcp,1.000
lo=lo2,4840.00,usb,rcp,1.000
" local commands for local oscillators and receiver/telescope settings – site specific
jbte1=1
jbte2=1
band=hl
aglos=a1,298.8,-3.0
jblos=452.2,120.0,38.0
" make sure cal is off and offsets are set – site specific
calloff
initoff
" setup a standard set of patches etc.
patch=lo1,1l,3l,5l,7l,9l,11l,13l
patch=lo2,2l,4l,6l,8l,10l,12l,14l
initoff
calloff
pcalform=1u,1,8,0
pcalform=2u,1,8,0
pcalform=3u,1,8,0
pcalform=4u,1,8,0
pcalform=5u,1,8,0
pcalform=6u,1,8,0
pcalform=7u,1,8,0
pcalform=8u,1,8,0
pcalform=9u,1,8,0
pcalform=au,1,8,0
pcalform=bu,1,8,0
pcalform=bu,1,8,0
pcalform=du,1,8,0
tapeform= 1,-319, 2, 31, 3,-271, 4, 79, 5,-223, 6, 127
tapeform= 7,-175, 8, 175, 9,-127, 10, 223, 11,-79, 12, 271
tapeform= 13, -31, 14, 319
form=m,16.000,1:4
tracks=v0,v1,v2,v3,v4,v5,v6,v7
trackform=2,2us,6,2um,10,1us,14,1um,18,4us,22,4um,26,3us,30,3um
trackform=3,6us,7,6um,11,5us,15,5um,19,8us,23,8um,27,7us,31,7um
trackform=4,10us,8,10um,12,9us,16,9um,20,12us,24,12um,28,11us,32,11um
trackform=5,14us,9,14um,13,13us,17,13um
poaid
tpicd
enddef
Appendix 6: Standard FLUX.CTL file

* flux.ctl - source flux control file
* source records:
* originally from John Conway based on (Casa, Cygnusa, TauA) from Baars et al
* 1977, AA, 61, 99 and (others) Ott et al 1994, AA 284, 331, see sflux.f
* subroutine, WEH 020813
* min freq on L band sources decreased to 500 per John Conway, WEH 0209xx
*
* freq MHz  ---- flux 10** ----   "     FS
* source  type  min  max  log   log(f) 2log(f) size  model
3c48     c   500 23780 2.465 -0.004 -0.1251   1.5 gauss 100    1s
3c123    c   500 23780 2.525  0.246 -0.1638  23   gauss 100    23s 5s
3c147    c   500 23780 2.806 -0.140 -0.1031   1   gauss 100    1s
3c161    c   500 10550 1.250  0.726 -0.2286   3   gauss 100    3s
3c218    c   500 10550 4.729 -1.025  0.0130  47   gauss 100   47s 14s
3c249.1  c   500  5000 6.757 -2.801  0.2969 200   gauss 100  200s 14s
3c286    c   500 32000 2.537 -0.565 -0.0404  1.5 gauss 100   15s
3c309.1  p   500 32000 2.617 -0.437 -0.0373   1.5 gauss 100   1.5s
3c348    c   500 10550 3.852 -0.361 -0.1053 170   gauss 100  170s 25s
3c353    c   500 10550 3.148 -0.157 -0.0911 210   gauss 100  210s 60s
cygnusa c    20  2000 4.695  0.085 -0.178  115   2pts  115s
3c380    p  2020  2520 1.041  0      0        1  gauss 100 1s
3c381    p  2080  2520 0.716  0      0        1  gauss 100 1s
3c491    p  2020  2520 1.204  0      0    270 gauss 100 4.5m
3c491    p  2080  2520 0.875  0      0    270 gauss 100 4.5m
0521m365 p  2020  2520 1.130  0      0  15  gauss 100 15s
0521m365 p  2080  2520 0.740  0      0  15  gauss 100 15s
sun      p  2020  2520 5.60206 0      0  1872 disk 0.52d
sun      p  2080  2520 6.39794 0      0  1872 disk 0.52d
moon     p  2020  2520 3.35218 0      0  1872 disk 0.52d
moon     p  2080  2520 4.49136 0      0  1872 disk 0.52d
oriona   p  2020  2520 2.64345 0      0  240 gauss 100 4m
oriona   p  2080  2520 2.53147 0      0  240 gauss 100 4m
*

Flux of ngc7027 scaled by -0.5% per year (from Ott et al 1994) to
epoch 13th Oct 2003 gives a flux density reduction to 93.7%
of the 1990 level. John Conway 030205
* nc7027 c 10550 43200 1.2937 -0.134  0   10  gauss 100 7s 10s
* Flux density of DR21 at K band taken from Ott et al (1994)
  Ott et al 1994. John Conway 030205
* dr21 c 21000 24000 1.231  0.000  0.0  20  gauss 100 20s 20s
*
* casa is special name with flux decreasing from 1980.0
* casa p 300 31000 5.745 -0.770  0  240 disk 4m
*
* the following points added from FS Manual WEH 0208xx
* 3c48 c 500 23780 2.465 -0.004 -0.1251 1.5 gauss 100 1s
3c123 c 500 23780 2.525 0.246 -0.1638 23 gauss 100 23s 5s
3c147 c 500 23780 2.806 -0.140 -0.1031 1 gauss 100 1s
3c161 c 500 10550 1.250 0.726 -0.2286 3 gauss 100 3s
3c218 c 500 10550 4.729 -1.025 0.130 47 gauss 100 47s 14s
3c227 c 500 5000 6.757 -2.801 0.2969 200 gauss 100 200s 50s
3c249.1 c 500 5000 2.537 -0.565 -0.0404 15 gauss 100 15s
3c286 c 500 32000 2.537 -0.565 -0.0404 1.5 gauss 100 1s
3c295 c 500 32000 1.490 0.756 -0.2545 5 gauss 100 5s 1s
3c309.1 p 500 32000 2.617 -0.437 -0.0373 1.5 gauss 100 1.5s
3c348 c 500 10550 3.852 -0.361 -0.1053 170 gauss 100 170s 25s
3c353 c 500 10550 3.148 -0.157 -0.0911 210 gauss 100 210s 60s
cygnusa c 20000 4.695 0.085 -0.178 115 2pts 115s
cygnusa c 2000 31000 7.161 -1.244 0.0 115 2pts 115s
taurusa c 500 35000 3.915 -0.299 0.0 300 gauss 100 4.2m 2.6m
* changed to "p" per Alex Kraus, WEH 020814
3c380 p 2020 2520 1.041 0 0 1 gauss 100 1s
3c381 p 2020 2520 0.716 0 0 1 gauss 100 1s
3c391 p 2020 2520 1.204 0 0 270 gauss 100 4.5m
3c391 p 2080 2520 0.875 0 0 270 gauss 100 4.5m
0521m365 p 2020 2520 1.130 0 0 15 gauss 100 15s
0521m365 p 2080 2520 0.740 0 0 15 gauss 100 15s
sun p 2020 2520 5.60206 0 0 1872 disk 0.52d
sun p 2080 2520 6.39794 0 0 1872 disk 0.52d
moon p 2020 2520 3.35218 0 0 1872 disk 0.52d
moon p 2080 2520 4.49136 0 0 1872 disk 0.52d
oriona p 2020 2520 2.64345 0 0 240 gauss 100 4m
oriona p 2080 2520 2.53147 0 0 240 gauss 100 4m
*3c84 from DBS flux table, note source is variable, WEH 020916
* 3c84 p 2020 2520 1.60205 0 0 1 gauss 100 1s
3c84 p 2080 9080 1.69987 0 0 1 gauss 100 1s
Appendix 7: Example of one cycle from an AQUIR log file

2004.047.16:34:49.10;Log Opened: Mark IV Field System Version 9.6.9
2004.047.16:34:49.10;location,JB-LVL , 2.31,53.23,83.0
2004.047.16:34:49.10;horizon1,0.,20.,360.
2004.047.16:34:49.11;antenna,76.0,15.0,10.0,-85.0,330.0,1.0,90.0,azel
2004.047.16:34:49.11;equip,mk4,mk4,none,mk4,500.10,3,a/d,102,60,20,none,41
2004.047.16:34:49.11;drivem11,330,270,yes
2004.047.16:34:49.11;drivem12,100
2004.047.16:34:49.11;head10,all,all,all,odd,adaptive,no,5.0000,1
2004.047.16:34:49.11;head11,311.5,29.6,-9.4,326.7,31.2,12.8,155.62,155.62
2004.047.16:34:49.11;head12,376.1,35.4,-129.6,308.4,28.6,26.3,154.07,154.07
2004.047.16:34:49.11;time,0.000,0.000,ntp
2004.047.16:34:49.11;flagr,-100
2004.047.16:34:49.11;calrx/calrx,fixed,1510.00,1510.00
2004.047.16:34:49.11;logpar/* log the current receiver/antenna settings
2004.047.16:34:49.11;logpar/* change mrlos to aglos pb 040212
2004.047.16:34:49.12;source
2004.047.16:34:49.12;jblos
2004.047.16:34:49.12;aglos
2004.047.16:34:49.12;lo
2004.047.16:34:49.12;band
2004.047.16:34:49.12;lo2/lo1,1510,usb,lcp,1,0
2004.047.16:34:49.12;lo2/lo2,1510,usb,rcp,1,0
2004.047.16:34:49.12;lo2/lo3,1510,usb,rcp,1,0
2004.047.16:34:49.12;poff/off
2004.047.16:34:49.12;atten/25,25,25,25
2004.047.16:34:49.25#antcn#tr/Lovell,VLBI-FS,062710.1,-5.88,J2000,0.0001,0.0007,0.0200,-0.0010
2004.047.16:34:49.25#antcn#tr/Lovell,VLBI-FS,114.33,10.06,J2000,0.0001,0.0007,0.0200,-0.0010
2004.047.16:34:49.25#antcn#rx/Lovell,5GHz,Low,452.20,120.0,38.0,25,25
2004.047.16:34:49.25;azeloff/0.02000,-0.00100
2004.047.16:34:49.33;vc01/120.99,2.000,u,10,10,rem,lock,6528
2004.047.16:34:49.40;vc02/120.99,2.000,u,10,10,rem,lock,3565
2004.047.16:34:49.47;vc03/130.99,2.000,u,10,10,rem,lock,6123
2004.047.16:34:49.54;vc04/130.99,2.000,u,10,10,rem,lock,4719
2004.047.16:34:49.61;vc05/140.99,2.000,u,10,10,rem,lock,8587
2004.047.16:34:49.68;vc06/140.99,2.000,u,10,10,rem,lock,7680
2004.047.16:34:49.75;vc07/150.99,2.000,u,10,10,rem,lock,5653
2004.047.16:34:49.82;vc08/150.99,2.000,u,10,10,rem,lock,9296
2004.047.16:34:49.89;vc09/160.99,2.000,u,10,10,rem,lock,6024
2004.047.16:34:49.96;vc10/160.99,2.000,u,10,10,rem,lock,6025
2004.047.16:34:50.03;vc11/170.99,2.000,u,10,10,rem,lock,4107
2004.047.16:34:50.10;vc12/170.99,2.000,u,10,10,rem,lock,7480
2004.047.16:34:50.17;vc13/180.99,2.000,u,10,10,rem,lock,7794
2004.047.16:34:50.24;vc14/180.99,2.000,u,10,10,rem,lock,8808
2004.047.16:34:50.24;initp
2004.047.16:34:50.24;caloff
2004.047.16:34:50.24;fivetp=azel,1,7,0,3,2,11,1200
2004.047.16:34:50.24;onoff=az,2,60,5,0,1200,alvc
2004.047.16:34:50.24;check=
2004.047.16:34:50.24;synco aquir &
2004.047.16:34:50.24;caloff
2004.047.16:34:50.25;caloffrd/**turn off cal diode..
<table>
<thead>
<tr>
<th>Source</th>
<th>Az</th>
<th>El</th>
<th>De I</th>
<th>Center</th>
<th>Comp</th>
<th>Tsys</th>
<th>SEFD</th>
<th>Tcal(j)</th>
<th>Tcal(r)</th>
</tr>
</thead>
<tbody>
<tr>
<td>VAL 3c161</td>
<td>114.3</td>
<td>10.1</td>
<td>9u</td>
<td>1 l</td>
<td>1671.9</td>
<td>0.9043</td>
<td>74.32</td>
<td>3.533</td>
<td>0.5339</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>8u</td>
<td>2 r</td>
<td>1681.9</td>
<td>0.9616</td>
<td>63.88</td>
<td>5.14</td>
<td>0.8059</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>7u</td>
<td>1 l</td>
<td>1691.9</td>
<td>0.9043</td>
<td>74.32</td>
<td>3.533</td>
<td>0.5339</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>6u</td>
<td>2 r</td>
<td>1661.9</td>
<td>0.9616</td>
<td>63.88</td>
<td>5.14</td>
<td>0.8059</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5u</td>
<td>1 l</td>
<td>1651.9</td>
<td>0.9593</td>
<td>59.21</td>
<td>4.40</td>
<td>0.7484</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4u</td>
<td>2 r</td>
<td>1641.9</td>
<td>0.9897</td>
<td>64.12</td>
<td>46.6</td>
<td>6.534</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3u</td>
<td>1 l</td>
<td>1631.9</td>
<td>0.9626</td>
<td>49.33</td>
<td>41.8</td>
<td>8.476</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2u</td>
<td>2 r</td>
<td>1621.9</td>
<td>0.9897</td>
<td>64.12</td>
<td>46.6</td>
<td>6.534</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1u</td>
<td>1 l</td>
<td>1611.9</td>
<td>0.9626</td>
<td>49.33</td>
<td>41.8</td>
<td>8.476</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Source</th>
<th>Az</th>
<th>El</th>
<th>De I</th>
<th>Center</th>
<th>Comp</th>
<th>Tsys</th>
<th>SEFD</th>
<th>Tcal(j)</th>
<th>Tcal(r)</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIG</td>
<td>eu</td>
<td>0.83</td>
<td>55.89</td>
<td>22.5</td>
<td>4.230</td>
<td>4.234</td>
<td>0.42</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>cu</td>
<td>0.02</td>
<td>1.25</td>
<td>0.4</td>
<td>0.072</td>
<td>0.072</td>
<td>0.01</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>bu</td>
<td>0.02</td>
<td>0.72</td>
<td>0.1</td>
<td>0.067</td>
<td>0.067</td>
<td>0.01</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>au</td>
<td>0.02</td>
<td>1.25</td>
<td>0.4</td>
<td>0.072</td>
<td>0.072</td>
<td>0.01</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Maintenance Workshops

Antenna Gain Calibration

Part 2: Amplitude Calibration with GNPLT

Alastair Gunn
Jodrell Bank Observatory
University of Manchester
UK

alastair.gunn@manchester.ac.uk
1. Introduction

This document is a short "how to" guide to GNPLT main features covered by the Antenna Gain Calibration class at the IVS TOW. This is not meant to be a complete user manual.

GNPLT is a Tcl/Tk program distributed together with the Field System for examining and analyzing the accuracy of the amplitude calibration of a telescope. A good calibration depends on how accurately, the $T_{Cal}(Jy)$ is predicted thanks to the combination of gain curve and $T_{Cal}(K)$ versus frequency. These calibration parameters are stored in the control .rxg files - GNPLT allows updating this information starting from a Field System log file containing ONOFF data.

2. Plotted Quantities

GNPLT is mostly focused on calibration parameters but it is also able to plot many others versus variables like frequency, elevation, azimuth, airmass and time. All these quantities could be split into two groups: measured quantities and derived quantities.

2.1 Calibration parameters

Calibration parameters are loaded from .rxg files at start. In order to prevent modifications by accident, GNPLT copies these files into working files. DPFU, gain curve polynomial, $T_{Cal}(K)$ belong to this group. While running GNPLT, these parameters are fitted and changed to new values that can be stored, again in working files. Before exiting GNPLT, the user can decide whether to update the calibration parameters into the .rxg file with the ones present in the current working file, or not.

2.2 Measured Quantities

When a log file is opened, GNPLT imports these quantities from ONOFF records (VAL). The most important ones are $SEFD(Jy)$, $T_{Cal}(Jy)$ and Gain Compression. These values never change during GNPLT sessions. $T_{Cal}(K)$ and $T_{Cal}Ratio$ are also reported by ONOFF but they are recalculated by GNPLT every time that new calibration parameters are fitted.

2.3 Derived Quantities

Derived quantities are calculated by GNPLT from measured quantities and also from calibration parameters. Gain, for instance, is calculated by dividing the $T_{Cal}(K)$ by the measured $T_{Cal}(Jy)$.

2.4 Description of Quantities

I. $T_{Cal}(K)$ - Noise calibration signal in Kelvin degrees. This calibration parameter is stored into .rxg files.

II. $T_{Cal}(Jy)$ - Noise calibration signal in Janskies. It's given by $T_{Cal}(Jy) = \frac{F_{source} \cdot (T_{Cal} - T_{sky})}{T_{source} - T_{sky}}$

where $F_{source}$ is the flux density of a known radio source.

III. $DPFU(K/Jy)$ - Degrees Per Flux Unit. This calibration parameter is the maximum height of the gain curve.

IV. $SEFD(Jy)$ - System Equivalent Flux Density, which is, in brief, the system temperature in Janskies.

V. Gain Compression - This is obtained by calculating the ratio of variation in counts switching the cal on when on source to the change in counts when off source. This ratio should be close to one as much as possible. If this does not happen, any other measured parameters are likely to be unreliable. For instance, the presence of RFI could affect this value.
VI. $T_{CalRatio}$ - This is a derived quantity. It is the ratio of measured $T_{Cal}(Jy)$ by ONOFF to the one predicted by calibration parameters. This provides an indication of how well your telescope is calibrated.

VII. $T_{rec}(K)$ - Receiver temperature in Kelvin Degrees.

VIII. $T_{spill}(K)$ - The system temperature contribution due to spillover.

IX. Airmass - Defined as $\frac{1}{\sin(elevation)}$.

3. Starting GNPLT

A main program composes this software: GNPLT, which is the GUI that displays all the data and permits all the user operations over them. GNPLT makes use of two other programs: GNDAT and GNFIT.

GNDAT takes care of parsing the log file and extracting all the relevant data. GNFIT performs the curves fitting and returns the curve polynomial, the RMS, and the number of iterations needed.

In order to start the program it is sufficient to run GNPLT. At the command prompt of your Field System machine type "gnplt". GNPLT can also accept two command line arguments, one is -r which forces the program to auto-replot every time the user makes selections on plot axes, the second one is the log file name.

4. The 'File' menu

4.1 Opening a log file

The first method is the command line argument as described before. Another way to open a log file is to select the 'New' menu item. A window will open that lets you select the file name and location. If the file you selected is valid, GNPLT begins to parse the log by running GNDAT. When this process is completed successfully the status bar of the main window should say 'Ready'. During this stage all menus are also set up.

4.2 Printing

GNPLT is capable to print the plots in the encapsulated postscript format (eps). On the 'File' menu there is the 'Print' menu item that allows printing the current plot. A new window labeled 'print plot' will open; if you select 'printer' as destination, the 'lpr' command will be use to print the plot, if you choose 'file' the output will be the file specified in the 'Filename' entry field. If no directory is specified, the current directory is used.

5. Selecting the axes and plotting quantities

Before you can plot anything, you have to choose the items for the X and Y axes. On the 'Items(X-Axis)' menu you have five different options that are self-explaining: Time, Elevation, Frequency, Azimuth, and Airmass. The 'Items(Y-Axis)' menu consists of three sections. First, there are the standard quantities from the log file. Then, you have the 'Assumed Items' with all the information reported by the .rxg file. Finally, you have the 'Gain' cascade menu, which has four additional options that differ in how the gain is calculated. This section is a little bit more complicated and it will be discussed later.
6. Replotting

When you have selected what is to be plotted you will have to replot. This could be done by either clicking the 'Replot' menu item on the 'Edit' menu or by pressing the 'r' key on your keyboard. The replot could also be performed automatically: if you start GNPLT with flag '-r' on the command line or if you select 'Yes' on the cascade menu 'Auto Replot' located on the 'Edit' menu, GNPLT will automatically replot every time you change the axes.

7. Selecting sources and frequencies

By default GNPLT plots all the observed frequencies and sources in the log file. This case is very rarely needed, so GNPLT allows you to select specific sources and frequencies.

7.1 Source selection

On the 'Select Source' cascaded menu located on the 'Edit' menu there are four items:

I. 'All' - Select all the sources.
II. 'All Calibrators' - Select all sources that are calibrators.
III. 'All Calibrators & Pointing' - Select all calibrators and pointing sources.
IV. 'None' - No sources at all.

If you want to be more detailed, a sub menu for each source is added. This menu(s) lists all the times that the source was observed; by clicking these check buttons you can add/remove these scans from the plot.

7.2 Polarization selection

On the 'Edit' menu there are two cascade menus, one for the 'Left' polarization, one for the 'Right' polarization. On each of them there are three command buttons:

I. 'All' - Select all frequencies for that polarization.
II. 'No Left'/No Right' - Deselect all frequencies for that polarization.
III. 'No Left or Right' - Deselect all frequencies for both polarizations.

Below the command buttons there is a variable number of buttons labeled with LO values; this number depends on how many LOs are present in your log file. Clicking one of them selects and deselects all the frequencies associated to that LO. Finally, you can find as many check buttons as the number of frequencies observed. These check buttons report also the mnemonic of the device/detector. With these widgets you can switch the associated frequency on and off.

8. Highlighting

8.1 Highlighting sources

All the sources in the log file will be displayed as radio buttons on the 'Source' menu. There is also a radio button for 'All' sources. When you click on one of these radio buttons all the points for that source are highlighted (that means they are filled with black ink). In case you replot or select 'All' they turn white again.

On the 'Source' menu there is also the cascade menu 'Select Display' that allows to control how the data points are displayed inside the plot:

I. 'Points' - Data are displayed as circles.
II. 'Letters' - Data are represented by a letter in the same position in which the points would normally be.
III. 'Points and Letters' - This is the default; data are displayed as a combination of circles and letters.
It must be noted that just right of the plotting area there is a box, labeled 'Source Legend', indicating which source each letter is associated with.

**8.2 Highlighting frequencies**

The 'Frequencies' menu works just as the 'Source' menu. All the currently plotted frequencies are associated with a radio button. Clicking the radio button will highlight all the points with that frequency.

**9. Scaling**

The scaling functionalities are accessible through the 'Scaling' menu. This menu controls the conditions on which the limits of both the axes are set. The default is to let GNPLT choose the limits for you.

**9.1 Autoscaling**

There are two different types of autoscaling on the 'Scaling' menu. For both options GNPLT will set the axes limits depending on what the user has selected on the 'Edit' menu. If you choose to 'Autoscale Including Deleted', all points matching your selection will be used to calculate axes limits, on the contrary if you choose to 'Autoscale Not Including Deleted', all deleted (see section 10) points will be left out.

**9.2 Manual scaling**

The radio button 'Manual' on the 'Scaling' menu allows you to set axes limits. A new window, showing the current limits, will open. You are now enabled to change what you prefer and when the 'Ok' button is pressed the selected limits are used. Before applying these limits some checks are performed, so if you inserted bad values (i.e. the maximum is smaller than minimum) you'll get an error message on the status bar. You also might want to zoom an area, this can be done using the left mouse button and dragging a rectangle, the selected region will be displayed in more detail.

**10. Data editing**

Often, in order to obtain a good fitting and so a better accuracy for calibration parameters it is necessary to delete some points that are noisy. A deleted point is not included in the input data of the fitting routine. A point status is described by its color:

I. White - the point is included, i.e. the point fits the user selection and is not deleted (clicked)
II. Red - the point is deleted (see section 10.1)
III. Black - the point is highlighted.
IV. Blue - the point is selected but it is outside the plotting limits, it is drawn on the plot borders.

Next to the plot there is the information box. This box reports information on how many points have been highlighted (see section 8.0), selected (points that are inside the user selection), included (points that are selected and not deleted) and finally on how many points are present in the log file.

**10.1 Mouse editing**

Moving the mouse cursor close to a point on the plot all the data related to that point are displayed on the right side of the main window, including time, frequency, polarization, etc.

Clicking on a point turns it red, i.e. the point is deleted from calculations. If you want to throw away a group of points just draw a box with the right mouse button around them. If the 'Shift' key is pressed while deleting a point, all the observations that have the same time will be deleted. If you want to
restore a deleted point it is sufficient to click on it again. A group of points could be undeleted by dragging an area with the middle mouse button.

10.2 Editing out the bad data

As already discussed the Gain Compression could be a good indication on whether the data are reliable or not. The fastest way to discard the bad data based on Gain Compression is to click the "Delete points with bad GC" on 'Edit' menu. A window opens, where you can select the upper and lower thresholds, beyond which data are rejected. This operation is highly recommended before any further analysis.

10.3 Deleting point outside plot

If you want all points outside the current plot limits to be deleted, you can achieve this by the 'Delete points outside plot' on the 'Edit' menu.

10.4 Undelete points

Sometimes you may want to restore all previously deleted points and to display again the points outside the limits. This operation is particularly useful when the display, for some reason, doesn't quite respond to your request. The quickest way to do this is to use the command 'Undelete All For This Selection' on 'Edit' menu. The 'Undelete All Points in Log' command does the same except for the fact that it also clears all user selections done via the 'Edit' menu.

11 Overview on amplitude calibration

In order to get accurate calibration for VLBI you will need to tune DPFU or/and \( TCal(K) \) versus frequency. If the model given by the combination of both these parameters is not consistent, then the prediction of the \( TCal(Jy) \) will be different from the one measured by ONOFF using a source of known flux density. For VLBI purposes you could focus only one between DPFU and \( TCal(K) \), but ideally you should choose to tune both these parameters and to describe your system as close to reality as possible.

Generally speaking you should update the parameter you are more doubtful about, i.e. the parameter that mostly differs from what you expect.

12 Checking gain curve and DPFU

The first step you need is to select the polarization and LO on 'Edit' menu (see section 7.2). Please notice that although left and right polarization share the same gain curve polynomial they have different DPFU. This means that once you fitted the gain curve for one polarization the other must share the same curve.

The second step is to plot Gain versus elevation. The gain is a derived quantity and is calculated from \( TCal(Jy) \) in the log file and an assumed \( TCal(K) \). The 'Gain' drop down menu on 'Items(Y-axis)' menu gives three choices on where to obtain this \( TCal(K) \):
   I. 'TCal from working file' - This is the more common choice, the TCal will be read from the working file.
   II. 'TCal from user input' - A single value can be inserted manually and it will be the same for all the frequencies.
   III. 'Specify gain for elev. range' - The \( TCal(K) \) will be set to a value such that the gain will have a certain mean value over a range of elevations.
Last two choices were provided in order to allow the user to input data taken from external calibrations (for example from calculating the antenna gain from its area and efficiency).

Having done these two operations the 'Tools' menu is now populated by the tools needed to fit a gain curve:

I. 'Gain Curve in working file' - switching on/off this check button displays/removes the gain curve from working file (solid green line).

II. 'Fitted Gain Curve' - switching on/off this check button displays/removes the fitted gain curve (dashed black line). The combination of these two commands is very useful to compare the old curve with the new one and decide whether to update the working file or not.

III. 'Fit to' - This item is a cascade submenu where there are three different fitting options:
   a. 'New DPFU' - the existing gain curve in the .rxg working file will be used to calculate a new DPFU for the current polarization.
   b. 'Gain Curve and DPFU' - A dialog window will appear. In that box you will be able to select the degree of the curve polynomial and the type of the gain curve (ALTAZ or ELEV). The result is a new gain curve and DPFU for that polarization.
   c. 'Scale TCal(K)' - This will cause the \( TCal(K) \) in the working file to be scaled by a factor. This factor is the average of the gain divided by \( DPFU \) times the gain curve, averaged over all the points.

IV. 'Update Working File' - This will update the .rxg working file with the last fit. After the updating, the last fitted curve turns green since it is now the curve in the .rxg working file.

The step-by-step check list you need to obtain gain curve and DPFU from your data, is:

I. Open a log file.
II. Delete bad data using Gain compression.
III. Select source(s).
IV. Select a polarization.
V. Plot Gain (using \( TCal(K) \) from working file) versus elevation.
VI. Delete noisy points.
VII. Fit a new gain curve and \( DPFU \).
VIII. If you are satisfied, update the working file.
IX. Select the other polarization.
X. Replot.
XI. Delete noisy points.
XII. Fit for a new \( DPFU \).
XIII. If you are satisfied, update the working file.
XIV. Done. Before exiting, remember to update the original .rxg file if you want to store new parameters definitively.

12. Checking \( TCal(K) \) versus frequency

Also in this case one polarization should be analyzed at a time. After plotting \( TCal(K) \) versus frequency you can use the options under the 'Tools' menu:

I. '\( TCal(K) \) curve in file' - switching on/off this check button displays/removes the \( TCal(K) \) curve from working file (solid green line).

II. 'Fitted \( TCal(K) \) curve' - switching on/off this check button displays/removes the fitted gain curve (dashed black line). Basically these two commands work in the same way the buttons for the gain curve do.

III. 'Fit for \( TCal(K) \)' - This item is a cascade submenu where there are two different options:
   a. 'Average at each freq.' - GNPLT will average the \( TCal(K) \) value at each frequency and then draw a line (dashed black line) between these points.
   b. 'Median at each freq.' - GNPLT will calculate the median (average of the two middle values) of the \( TCal(K) \) values at each frequency and then draw a line (dashed black line) between these points.
IV. 'Update working file' - This will update the .rxg working file with the last fitted TCal(K) table. After the updating, the last fitted curve turns green since it is now the curve in the .rxg working file.

The step-by-step checklist, you need to obtain gain curve and DPFU from your data, is:

I. Open a log file.
II. Delete bad data using Gain compression.
III. Select source(s).
IV. Select a polarization.
V. Plot TCal(K) versus frequency.
VI. Delete noisy points.
VII. Fit a new TCal(K) table for the current polarization.
VIII. If you are satisfied, update the working file.
IX. Select the other polarization.
X. Replot.
XI. Delete noisy points.
XII. Fit a new TCal(K) table for the current polarization.
XIII. If you are satisfied, update the working file.
XIV. Done. Before exiting, remember to update the original .rxg file if you want to store new parameters definitively.

13 Opacity corrected gain

GNPLT allows you to correct your data for opacity (τ). This capability makes sense only if you are analyzing data acquired at frequencies greater than 8 GHz. In fact, doing an opacity correction at 4/5 cm or higher will probably make your calibration worse.

This feature will only be available if the receiver temperature Trec(K) is included in your .rxg file. The spillover table versus elevation should also be supplied. Anyway this last information is optional and it could be missing. In that case Tspill(el)=0 will be assumed by GNPLT.

GNPLT make use of this formula: \[ T_{sys}(el) = T_{rec} + T_{spill}(el) + T_{atm}(1 - e^{-\tau}) \]. For each data point the \( e^{-\tau} \) is found. The opacity corrected gain is then \( e^{-\tau} \) times the uncorrected gain. In order to enable this feature the radio button 'Correct for opacities' should be clicked. This button is on 'Gain' cascade menu already described in section 12. The program will then prompt the user for the Tatm(K). The ambient temperature at the moment of the observation -15k is often used. A corrected gain curve is obtained by fitting in the same way as usual. The curve polynomial in the .rxg file will be marked by the tag 'opacity_corrected'.

13.1 Fitting for Trec(K)

Opacity correction are clearly very dependant on having a good Trec(K). GNPLT allows you to check if the value of the assumed Trec(K) is consistent by comparing it with an estimation from your data. If you plot Tsys-Tspill versus airmass, the 'Tools' menu is set up with the commands you will need to fit a new Trec and to update working file, if needed:

I. 'Mark Trec from working file' - This check button displays/removes the current Trec(K) marker. If the marker is off the plot limits, a message will appear on the status bar.
II. 'Mark fitted Trec' - This check button displays/removes the last fitted Trec(K) marker. If there is no fitted Trec(K) a message will appear on the status bar.
III. 'Fit for Trec' - You will be asked to insert the Tatm and a time interval over which the atmospheric opacity is supposed to be constant. Data from each time segment will be fitted by the curve \[ T_{sys} - T_{spill} = T_{rec} + T_{atm}(1 - e^{r0 \cdot Airmass}) \], where \( r0 \) is the zenith opacity. If your data is collected during N hours and you choose a K hours interval then \( |N/K| \) curves are calculated.
IV. 'Recalculate Trec' - This command can be used to recalculate the weighted mean after some editing (i.e. Trecs could be deleted as normal data points).
V. 'Update working file' - This will update the .rxg working file with computed $T_{rec(K)}$.

14. Shortcut methods

Under the 'Edit' menu you can find three shortcuts for plotting gain versus elevation, TCal(K) versus frequency and Tsys-Tspill versus airmass. These commands should speed up editing and selection but what is plotted is more restricted than if using the general method. For example, for gain versus elevation only a single frequency (detector) can be plotted and the needed TCal(K) is always taken from the working file.